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Attention: 

1. With the products improvement,HYCON Technology Corp. reserves the right to change the content of 

this datasheet without further notice. For most up-to-date information, please constantly visit our website: 

http://www.hycontek.com . 

2. HYCON Technology Corp. is not responsible for problems caused by figures,application circuits and so 

on narrated herein whose related industrial properties belong to third parties. 

3. Specifications of any HYCON Technology Corp. products detailed or contained herein stipulate the 

performance, characteristics, and functions of the specified products in the independent state. We does not 

guarantee of the performance, characteristics, and functions of the specified products as placed in the 

customer”s products or equipment. Constant and sufficient verification and evaluation is highly advised. 

4. Please note the operating conditions of input voltage, output voltage and load current and ensure the IC 

internal power consumption does not exceed that of package tolerance. HYCON Technology Corp. assumes 

no responsibility for equipment failures that resulted from using products at values that exceed, even 

momentarily, rated values listed in products specifications of HYCON products specified herein. 

5. Notwithstanding this product has built-in ESD protection circuit, please do not exert excessive static 

electricity over the performance of protection circuit. 

6. Products specified or contained herein cannot be employed in applications which require extremely high 

levels of reliability without written permission, such as device or equipment affecting the human body, 

health/medical equipments, security equipments, vehicle equipments,or any apparatus installed in aircrafts 

and other vehicles that will affect human body.Don’t use as their component. 

7. Despite the fact that HYCON Technology Corp. endeavors to enhance product quality as well as 

reliability in every possible way, failure or malfunction of semiconductor products which will led to human 

injury,fire accident ,etc may happen. Hence, users are strongly recommended to comply with safety design 

including redundancy and fire-precaution equipments to prevent any accidents and fires that may follow. 

8. Use of the information described herein for other purposes and/or reproduction or copying without the 

permission of HYCON Technology Corp. is strictly prohibited. 
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1. HYCON-IDE Overview 

1.1 Introduction 

 To facilitate customers of using HYCON MCU series products,developed HYCON-IDE platform to 

make Customers can implement emulation of the end-products on this platform and program the code onto 

OTP of HY series products,and make customers’ products develop fast and sale in the market. 

  

1.2 HYCON-IDE Installation and System Requirement 

Minimum requirements for operating HYCON-IDE: 
 PC Hardware Request: 

PC compatible machine with PENTIUM® CPU 

128 MB Memory (256MB is recommended) 

10 GB Hard Disk Space 

 

 Supporting Products: 

 -HY12P65 

 

 Supporting Hardware Model No.: 

-HY12S65-DK01 development kit 

 

 Supporting Software Version: 

HY-CON IDEDMM V1.1 and above 

 

 Compatibility of Program Version: 

N/A 

 

.

http://www.hycontek.com/


 
HY12S65 
HYCON-IDE Software User Manual 

 

 

© 2012-2015 HYCON Technology Corp 
www.hycontek.com    

 APD-HYIDE009-V02_EN  
Page 5 

 

 OS:  

Windows 98SE  

Windows 2000 

Windows XP 

Windows Vista 

Windows 7 

 Support x86, 32bit system, 64bit system not in support. 

 Applicable Interface: 

USB Port 

1.3 Install and Remove 

 1.3.1 Install 

Note: For some Windows OS, it may require to have administrator identity to install the software to the 

computer. 

 Find and execute the file Setup.exe in the CD ROM or file.  

 Following the instruction window figure step by step to continue setup procedures. As shown in 

Figure 1-1. 

 First-time installation must initiate USB driver program, the setup procedures are as Figure 2 shown. 

 .
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Figure 1 
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Figure 2 

 Remove 
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Please remove the file of “HYCON-IDEDMM V1.1” in “Add/Remove Program” under Control Panel. 

1.4 Registration 

For first time using ICE for simulation or programming OTP chip, if information below appear or IDE 

using abnormally,users must log in.. 

 
Figure 3 

Registration Procedures: 
1. Please check the HyIDE Machine Number (HyIDE Code) on the parcel and send the number by 

e-mail or on-line registration. HYCON will send back another customer register code to you.  

2. Connect the HyIDE Control Board to PC through USB interface. 

3. Execute HYCON-IDE software (HYCONIDE.exe). Go to ”Option” and press ”Register”. 

4. Fill in the customer code in “Register Number” and click “Write” to start. 

 
Figure 4 

5. If the process is successful, a dialog will be shown as follows. 

 
Figure 5 
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6. If the process failed, a dialog will be shown as Figure 6. 

 
Figure 6 

7. Once the register is succeeded, Customers do not have to worry that other numbers may be written 

into the “Register Number”. 

.
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1.5 Demo Code Description 

 Starting C:\Program Files\HyIDE\HyconIDEDMM\DemoCode\Ref Code\Test.asm  

 Set the file as assembly main file 

 Assembly start and proceed program debug 

 
Figure 7 

 
Figure 8 
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Figure 9 

 Users can use any compiler to edit Source Code, as long as it can be stored in ASCII Code format. 

Source code will be reloaded when program compiles to ensure its correctness. Debugging and edit 

function will be depicted respectively in the following chapters. 
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2. HYCON-IDE Interface Description 

2.1 HYCON-IDE Edit Interface 

 
Figure 10 
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Edit Window 

 Open file  

Open the existing edited file in the disk 

 Set bookmark  
Using this function to go back to the bookmark instantly when many files were opened 

 Go to bookmark  

Jump to the default bookmark 

 Find string  

Find input string 

 Find next string  

 Go to page  

Using this function to switch files 

 Assemble  
Only acting assemble function not debug status. After assembled, a message window will show up 
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2.1.2 File 

 
Figure 11 

 
 New(N)→Add edit file newly 

 Open(O)→Open edited and saved file 

 Save(s)→Save file 

 Save as→Save as new file 

 Save All→Save all files 

 Close File→Close current file 

 Close All→Close all files 

 Open Project  Project includes, IC No., IDE interface, main program file name, current status and 

checksum. The project status will be loaded once this function is activated. 

 Save Project→Save project 

 Exit→Exit Hycon-IDE program 

2.1.3 Edit 

 
Figure 12 

·Undo→Undo last input or cancel 

   ·Cut→Cut selected area 
 
  ·Copy→Copy selected area 

Add edit file newly 

Open edited and saved file 

Save file 

Save as new file 

Save all 

Close file 

Close all 

Open project 

Save project 

Exit IDE 

Undo 

Cut 

Copy 

Paste 

Select All 
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·Paste→Paste copied area 

·Select All→Select all 
2.1.4 View 

 
Figure 13 

  ·Edit→Point edit interface to current used interface  

    ·Next File→Point next file to current used interface 
    ·Previous File→Point prev file to current used interface 
 
2.1.5 Assemble & Run 

 
Figure 14 
 
Assemble & Run (Emulation)  Assemble Source Code and execute debug mode 

Assemble     Only executing assemble, not debugging. This assemble will not generate error message 

according to IC part No.Error message will show up when the lines is error. It is usually used in generating 

OBJ Code (Object). 

Set Main File  Set the file as assembly main file. Files will be named after compiler generated file name, 

such as Hex, MAP, ASC…etc. 

Set Mode (Debug mode)  Debug through software or hardware is selective. 

 2.1.6 Interface Setup 

Point to edit interface 

Point to next file 

Point to prev file 

Assemble&Run 
Assemble 

Set main file 

Simulation 

Emulation 

Set Mode 
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Figure 15 
Interface Setup (select from option) 

 
Figure 16 
Chip Select: Select IC part no. Compiler will assemble the selected part no.’s program file. It will determine 

whether there is any misuse,like using non-existing Register or SRAM, or has the program exceeded the 

ROM Size.  

Build Options 

ICE Test 

OSC Calibratin 

Interface Setup 

Int Setup 

Register 

Chip Select 

Language Select 

Transpot Interface select 

IDE Mode Select 
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Language option: English and Chinese interface are selectable. 

Communication interface option: Select IDE communication interface. 

Mode option: Two choices, Emulate and debug, and programming. 

 

.
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Build Option 

 
Figure 17 
Assembler generated extension: it is selectable to produce below file formats. 

1. Binary file : Hex 

2. Obj file : obj 

3. List file: lst 

4. ADCII file: asc 

Font option: Choose editor’s fonts. 

Fill unused zone: Fill the unused zone with 0x0000 or 0xFFFF in the program. 

Simplified assemble: Simplified assemble function is selectable. When JMP or CALL is smaller than 2K, it will 

automatically transform to RJ or RCALL. If the arguments of CALL are set, it will not transform to RCALL. 

Program protection: Please refer to “Interface Setup” under Programming Window chapter. 

Assemble generated 

extension 

Font option 

Fill unused zone 

Simplified assemble 

Program protection 
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Interrupt Setup 

 

Figure 18 
Stop operation when Stack overflow: IDE will stop when Stack overflow. 

Monitor address: Select the monitored Register or RAM. The program will stop when the program executed 

RAM or Register value equals to the monitored Data. 

Monitor Data: Monitor value is set when the monitor Data is filled up. 

Monitor RAM bit: Monitor function will be activated if the monitor bit is ticked. The program will stop when the 

bit of Data value equals to the marked on bit. 

ICE Test 

 
Figure 19 

2.1.7 Windows 

Stop operation when 

stack overflow 

Monitor RAM bit 

Watch Address 

Watch Data 

SRAM Address 

Write Data into SRAM 

Read Data from SRAM 

ROM Address 

Write Data into ROM 

Read Data from ROM 

Test ICE Voltage 
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All the windows opened can be displayed horizontally or vertically. 

 
Figure 20 

2.1.8 Program Structure 
Before editing new program, users must select IC part number through interface setup; 

Different IC will have different Instruction Set, according to IC part number definition; it is classified as H08A 

and H08B instruction set;  

User can refer to the software appendix demo code, Chapter 1.6 gives illustration of demo code usage. 

Users can refer to following program structure to start writing program. Basic structure description is listed as 

below: 

Program Name Definition as: ***.ASM 

Register Name or RAM Definition as: ***.INC 

Two program contents are listed below:  

“Test.asm”& “H08.inc” 

 

“Main.asm” structure:               ; Program name can be any name 

Include    H12P.inc                    ; Special register names and address definition of HY12P series 

ORG        00H                         ; Declare program start 

JMP  START                     ; Jump to main program 

   

ORG        04H                         ; Declare interrupt flag address 

  NOP      ; Interrupt program 

RET   

 

START:                                    ; Start Main program. Label name definition can be any word 

CALL DELAY 

IDLE 

NOP 

 

DELAY: 

. 

. 

. 

RET   

END                                        ; End Program  

.
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Reference Document: 

IP User Manual: User’s Guide 

Instruction Set User Manual: H08A Instruction Set Manual   

HYCON-IDE Complier User Manual: HY-MCU COMPILER 
 2.1.9 Self-defined Instruction 

HYCON-IDE adds user self-defined instruction function from DMM version. This function provides user to 

self-define their familiar MCU instructions to be same with HY12P series instruction.. 

Usage description： 

All self-defined instruction function is installed under Inst.txt file. It is separated into two rows. The first 

instruction (first row) of every row is HYCON origin instruction name; users cannot make amendment to it. 

The second instruction (second row) is "User" self-defined instruction name.  

First and second instruction can only be separated by space, multi-space or Tab.  

Second instruction can be followed by semicolon (;) as remark. 

Second instruction name can be the same as the first one. 

The name of second instruction cannot be defined as any HYCON origin instruction name except the 

instruction in the same row. Otherwise, it is deemed as invalid and will adopt the origin instruction name to 

compile program.  

After users self-define the second instruction name, the first or second instruction name can be used when 

program compiling. 

Every row can only has one self-defined instruction name, any repeated instruction name will be deemed as 

invalid. 
For example： 

JMP    JUMP    JMM    JPP    JU  ;╳wrong definition way 

Repeated defined instruction or defined self-defined instruction will be deemed as invalid. 

Example:  

JMP   JUMP 

JMP  JPP  ;╳ instruction name redefine. JUMP will be deemed as invalid instruction, only JPP is valid. 

JPP   JU    ;╳ cannot use self-defined name to redefine 

JMP  JN   ;╳ cannot be defined as HYCON origin existed instruction name 

Correct definition is:  

JMP    JUMP 

.
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3. HYCON-IDE Debug Interface 

It can be classified into hardware debug and software debug. 

 Hardware debug 

The indication column is blue 

 Software debug 

The indication column is green 
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3.1 Fast Execution 

 
 Fast window switch 

(1) Switch to Edit window  

 

(2) Switch to Source window  

 

(3) Switch to Hex window  

 

(4) Switch to Ram window  

 

(5) Switch to Reg window  

 

(6) Switch to Watch window  
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 Fast Debug 

(1) Step back  

(2) Trace (Enter into Macro/vice program)  

(3) Step over (Not enter into Macro/vice program)  

(4) Skip Call  

(5) Execute (Free RUN)  

(6) Pause  

(7) Continue  

(8) Program replace   

(9) Back to edit mode  

 
Figure 21 

 
 Two methods to set or remove interrupt: 

1. Use mouse to select interrupt place in program code window or machine code window, press “F2” 

button to set or remove interrupt. 

2. Use mouse to select interrupt place in program code window or machine code window, double 

click the left key to set or remove interrupt. 
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Click mouse 
to set 

interval 
section

 
Figure 22 .
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3.2 RAM Window 

 
Figure 23 

 After opening RAM window, Bank will show the volume of the selected IC. Every Bank has 256 

byte. 

 Bank0 starts from 0x00 to 0xFF. Bank1 starts from 0x100 to 0x1FF…etc. 

 If the address does not exist, it will display “-”. 

 If users intend to switch Bank display, use cursor to point to the desired Bank zone, and then 

click the left key of the mouse to confirm. 

 If the address display numbers and is underlined,it means Hint is set. 

 Notice: The Address 0x00 ~ 0x0Eof Bank0 is indirect addressing register, it cannot be 

revised directly, the displayed value is not referable. If revise is required, please refer to 

Chapter 3.3. Revise indirect addressing Data or Address. 

 Function Display 

Click the mouse selection key (right key) 

 
Figure 24 

 Set Mark 

 Set Mark(new color) 

.
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 Reset Mark 

 Reset All Mark 

 Set Hint 

 Reset Hint 

 Reset All Hint 

 Load RAM Data 

 Save RAM Data 

 Save To excel 

 RAMBANK0 

 Hint 

SRAM defined by DS will automatically generate Hint in corresponding window address. When 

cursor point to the address, it will show the defined string. 

Ex: Program definition SRAM 
MEMAR      080h 
MD1          DS     1 
MD2          DS     1 
MD3          DS     1 
MDL1         DS     1 
MDL2         DS     1  
MDL3         DS     1  
MD4           DS     5 
S_REG        DS     1 
r_Len         DS     1 
SQRTmp       DS     4 
Temp          DS     16 

After assembling, it will enter into debug status, displaying memory window. 

When cursor points to 80h address, <80>:MD1 will be shown. 

When cursor points to 86h address, <86>:MD4[0] will show up. 

When cursor points to 87h address, <87>:MD4[1] will show up. 

 
Figure 25 
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 There are two ways to revise SRAM value 

1. Point the cursor to the selected revised lines, click mouse left key and Key IN by keyboard 

directly. 

2. Point the cursor to the selected revised lines, double click mouse left key, a window will pop up 

as Figure 26 shown. Users can key in on keyboard or press the button by mouse 

RAM Address RAM Data

Keyboard Key IN

Mouse Click

 
Figure 26 
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3.3 Register Window 

 
Figure 27 

 Modify Data or Address of indirect address 

As Figure 28 configures, using keyboard to Key IN or using cursor to click data ,then Address can be 

modified. 

 
Figure 28 

As Figure 29 configures, using Key IN of the keyboard or using cursor to click data ,then Data can be 

modified. 

 

Figure 29 
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 Modify WREG Data 

 
Figure 30 

 Modify Data of single 1byte or Word Register 

Click Zone Double click the mouse’s left key, 
a input interface will show up

Using keyboard to 
Key In directly

 

Figure 31 

 Modify Register single 1 byte or single 1 bit 

After configuring Bit as 1, it will be highlighted in white, blue digit 

After configuring Bit as 0, it will be marked in backcolor ,black digit 

 
Figure 32 
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3.4 Watch Window 

 
Figure 33 

 Watch Name  Monitor Data name, program uses EQU or DS defined name 

 Watch Address  Monitor Data Address 

 Watch Data  Display value, can select display arrangement from right to left or from left to 

right,and display in decimal or hexadecimal. 

 

Figure 34 

Hex (H  L): Hexadecimal display, address H/L from low to high 

Hex (L  H): Hexadecimal display, address L/H from high to low 

Dec (H  L): Decimal display, address H/L from low to high 

Dec (L  H): Decimal display, address L/H from high to low 

 Watch Data for Bin  Data ,display in binary system, only show up when using EQU defined 

address 

 Data Length  Data length, display DS definition length; it will display 2 when using EQU definition 

 Data Type  type of data,D = DS definition; C = EQU definition 

 

Add Watch 

Delete Watch 

Delete All Watches 

Hide Watch Address Load Properties 

Save Properties 

Clear All Properties 
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 Monitor EQU defined Register or RAM, click right key of the mouse and select the register or 

RAM to be monitored, as shown in Figure 35. 

 

Figure 35 

.

http://www.hycontek.com/


 
HY12S65 
HYCON-IDE Software User Manual 

 

 

© 2012-2015 HYCON Technology Corp 
www.hycontek.com    

 APD-HYIDE009-V02_EN  
Page 33 

 

3.5 Stack Window 

 
Figure 36 

 

Display stack layers

Display stack address

 
Figure 37 

Select display 

stack window 
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3.6 ADC Window 

Figure 38 

 
Figure 39 

 
 
 

.

http://www.hycontek.com/


 
HY12S65 
HYCON-IDE Software User Manual 

 

 

© 2012-2015 HYCON Technology Corp 
www.hycontek.com    

 APD-HYIDE009-V02_EN  
Page 35 

 

 AD1IP Network (ADSIP) 

(1) Click the network name with mouse left key, then AD1IP can go to the specified network 

(2) Click mouse left key and Figure 40 will be displayed,then on-off network can be 

selected 

 

Figure 40 

 AD1IN Network (ADSIN) 

(1) Click the network name with mouse left key, then AD1IN can go to the specified network 

(2) Click mouse left key and Figure 41 will be displayed,then on-off network can be 

selected. 

 

Figure 41 

 AD1FP Network (ADSFP) 

(1) Click the network name with mouse left key, then AD1FP can go to the specified 

network 

(2) Click mouse left key and Figure 42 will be displayed,then on-off network can be 

selected. 
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Figure 42  

 AD1FN Network (ADSFN) 

(1) Click the network name with mouse left key, then AD1FN can go to the specified 

network 

(2) Click mouse left key and Figure 43 will be displayed,then on-off network can be 

selected. 

 
Figure 43 

 AD1CHOP Network switch (ADSCHP) 

(1) Network is switchable by clicking mouse left key, 3 types are selective 

 

(2) Figure 44 will show up by clicking mouse left key, then users can select the switch 

network 

 

Figure 44 

 AD1 INPBUFF switch 

(1) Click the specified network name with mouse left key, ADSIPB/ADSINB switch will be 

ON/OFF 

(2) Click the specified network switch with mouse left key, ADSIPB/ADSINB switch will be 

ON/OFF 

 ADCCK option 

Click the specified network name with mouse left key, ADCCK will switch options. When 

ADCCK = OFF, HAO_OSC/10. When ADCCK = ON, HAO_OSC/20. 
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 ENADC 

Click the specified network name with mouse left key, ENADC will be ON/OFF. When 

ENADC = ON, ADC zone will display value 

 AD1RH Network (ADSRP) 

(1) Click the specified network name with mouse left key, AD1RH can select to that network 

(2) Click the specified network switch with mouse left key , AD1RH can select to that 

network 

(3) Figure 45 will show up by clicking mouse left key, then users can select the switch 

network 

 

Figure 45 

 AD1RN Network (ADSRN) 

(1) Click the specified network name with mouse left key, AD1RN can select to that network 

(2) Click the specified network switch with mouse left key, AD1RN can select to that 

network 

(3) Figure 46 will show up by clicking mouse left key, then users can select the switch 

network 

 

Figure 46 

 AD1 VRBUFF Switch 

(1) Click the specified network name with mouse left key, P_VERBUFF/N_VERBUFF 

switch will be ON/OFF 

(2) Click the specified network switch with mouse left key, P_VERBUFF/N_VERBUFF 

switch will be ON/OFF 

 ADGN Network 

 Figure 47 will show up by clicking mouse left key, then users can select the network 
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Figure 47 

 VRGN 

 Click the specified network name with mouse left key, VRGN can select to that network 

 Reset Comb Filter 

 Click the specified network name with mouse left key, RSTCOMB can select to that network. 

When RSTCOMB changed from OFF to ON, Comb Filter can be reset. 

 
 

 OSR1 Network(ADFOSR) 

 Figure 48 will show up by clicking mouse left key, then users can select the network 

 

Figure 48 

 ADC Display zone 

(1) Select ADC data output type  Hex or Dec output 

(2) Select ADC data output Bit  From 8 ~ 19 Bit output 

(3) Display output button  ADC output value will be displayed by clicking this button 

 ENLPF 

Click the specified network name with mouse left key, ENLPF will be ON/OFF. When 

ENADC = ON, LPF zone will display value 

 Reset LPF 

 Click the specified network name with mouse left key, RSLPF can select to that network. 

When RSLPF changes from OFF to ON, LPF can de reset. 

 OSR4 Network (LPFBW) 

 Figure 49 will show up by clicking mouse left key, then users can select to the network 
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Figure 49 

 ENSQUE 

Click the specified network name with mouse left key, ENSQUE will be ON/OFF. When 

ENSQUE = OFF, ∑>=<
N
X0:37RMS

2

. When ENSQUE=ON, 

∑>=<
N
X

0:37RMS
.
 

 ENRMS 

Click the specified network name with mouse left key, ENRMS will be ON/OFF.ON/OFF. 

When ENADC = ON, RMS zone will display value. 

 Reset RMS LPF 

 Click the specified network name with mouse left key, RSRMS can select to that network. 

When RSRMS changes from OFF to ON, RMS LPF can be reset. 
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3.7 Power Window 

 

Figure 50 

 
Figure 51 

 ENLDO 

Click the specified network name with mouse left key, ENLDO will be ON/OFF. ENLDO 

display status, when ENLDO = 1, VDDA output voltage. 

 LDO Network 

Figure 52 will show up by clicking mouse left key, and then users can select the switch 

network 

Click POWER 

Interface 
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Figure 52 

 ENVGG 

Click the specified network name with mouse left key, ENVGG will be ON/OFF. ENVGG 

display status, when ENVGG = 1, VGG output voltage 

 ENLCD 

Click the specified network name with mouse left key, ENLCD will be ON/OFF. ENLCD 

display status, when ENLCD = 1, start LCD 

 LCDPR 

Click the specified network name with mouse left key, LCDPR will be ON/OFF. LCDPR 

display status. 

 when LCDPR= 1, VLCD power sauce is generated from internal IC. 

When LCDPR= 0, VLCD power sauce is generated from external input pin 

 LCDBF 

Click the specified network name with mouse left key, LCDBF will be ON/OFF. LVDBF 

display status. 

 VLCD Network 

Figure 53 will show up by clicking mouse left key, and then users can select the switch 

network 

 

Figure 53 

 ENREFO 

Click the specified network name with mouse left key, ENREFO will be ON/OFF. ENREFO 

display status, when ENREFO = 1, REFO output voltage 

 SREFO 

Click the specified network name with mouse left key, SREFO will be ON/OFF, SREFO 

display status. 

When SREFO= 1, REFO power sauce is generated from internal IC. 

When SREFO= 0, REFO power sauce is generated from external PB< 4 > pin 
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 AGND Network 

Figure 54 will show up by clicking mouse left key, and then users can select the switch 

network 

 
Figure 54 
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3.8 MPN Window 

 
Figure 55 

Figure 56 
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 ENCMP 

Click the specified network name with mouse left key, ENCMP will be ON/OFF, ENCMP 

display status. 

 INCMP Network 

(1) Click the specified network name with mouse left key, INCMP can select to that 

network 

(2) Click the specified network switch with mouse left key, INCMP can select to that 

network 

(3) Figure 57 will show up by clicking mouse left key, and then users can select the switch 

network 

 

Figure 57 

 VRHCMP Network 

(1) Click the specified network name with mouse left key, VRHCMP can select to that 

network 

(2) Click the specified network switch with mouse left key, VRHCMP can select to that 

network 

(3) Figure 58 will show up by clicking mouse left key, and then users can select the switch 

network  

 

Figure 58 

 VRLCMP Network 

(1) Click the specified network name with mouse left key, VRLCMP can select to that 

network 
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(2) Click the specified network switch with mouse left key, VRLCMP can select to that 

network 

(3) Figure 59 will show up by clicking mouse left key, and then users can select the switch 

network 

 
Figure 59 

 VREF Network 

(1) Click the specified network name with mouse left key, VREF can select to that network 

(2) Click the specified network switch with mouse left key, VREF can select to that 

network 

(3) Figure 60 will show up by clicking mouse left key, and then users can select the switch 

network 

 

Figure 60 

 Measurement Mode Network 

(1) Click the specified network name with mouse left key, users can select to that network 

(2) Click the specified network switch with mouse left key, users can select to that network 

(3) Figure 61 will show up by clicking mouse left key, and then users can select the switch 

network 
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Figure 61 

 
 
 
 
 
 
 
 
 
 

 Multi-function Network 

(1) Click the specified network switch with mouse left key, users can select to that network 

(2) Figure 62 will show up by clicking mouse left key, and then users can select the switch 

network 
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Figure 62 
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3.9 Register Record 

If the register or SRAM has been revised manually after access to simulation window (hardware 

emulation or software simulation), the data will be recorded (no matter the RAM, Register, ADC, OP and CMP 

was revised by any window). The data will be revealed after pressing the button “SRAM record”. At this time, 

windows will suspend until it is closed to execute other commands. 

Figure 63 

Save record 

 load 
Clear recod 

 close 

Continuous 

uncontinuous

 

Add assembly file newly 

add current PC address .
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PC Stop Address

Add To Program

Add New Program

 

Figure 64 
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3.10 Hint Function of Source Code Window 

If users intend to know Register or SRAM value and Address in source code window, point the cursor to 

Register or SRAM, the name, address and data can be revealed. 

This function is only applicable to the arguments of instructions below:  

CLRF, ADDF, INF, INSZ, DCF, DCSZ, SUBF, COMF, ADDC, ANDF, IORF, XORF, SUBC, RRF, SETF, 

MULF, RLF, JZ, RRFC, RLFC, SWPF, DAW, INSUZ, DCSUZ, ARLC, ARRC, CPSG, CPSL, CPSE, TFSZ, 

BTFG BSF, BCF, BTSS, BTSZ, MVFF (Not Macro). 

 

 Only the first followed argument is effective when the instruction is bit as Figure 65 described. 

 When command is BCF, BSF, BTSS, BTSZ and BTGF, Byte value will be revealed if the cursor 

points to the first argument. If the cursor points to the second argument, it will display the 

specified Bit value (1 or 0) as Figure 66 illustrated. 

 When command is MVFF (not Macro), the first argument value will appear if the cursor points to 

the first argument. If the cursor points to the second argument, the second argument value will 

show up as shown in Figure 67. 

 If the argument is INDF0, POINC0, PODEC0, PRINC0, INDF1, POINC1, PODEC1 and PRINC1, 

the Data will be FSR0 or the address Data of FSR1 as Figure 68 described. 

 If the argument is PLUSW0 or PLUSW1, the Data is FSR0+WREG or the address Data of 

FSR1+WREG as illustrated in Figure 69. 

Name Address Data

 
Figure 65 

 

Display Byte Display bit

 

Figure 66 
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Display the first Argument Display the second Argument

 

Figure 67 

Name FSR0 Address Data

 
Figure 68 

Name FSR0+WREG Address Data

 
Figure 69 
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4. Programming Windows 

4.1 Interface Setup 

To enter into programming windows Click “Options”, a option window will appear. Click the interface 

setup, as shown in Figure 70. 

Click 
Option

Interface setup 
window pops up

Select 
Interface Setup

 
Figure 70 

Chip Select  Choose the specific programming IC part no. If programmed IC differs from the selected 

IC, Blank Check, Program and Verify will fail.  
Language  Choose operation interface language, like Chinese or English. 
Hardware Interface  USB interface or Parallel Port interface is selectable. 
IDE Mode  Programmer or emulate and Debug is selectable.  

When interface setup finished, click Build Options to select programming configuration. As described in 

Figure 71. 

Select 
Build Options

 
Figure 71 

Select programming chip part no. 

Select operation interface language 

Select interface communication mode 

Select programming model 

Select filling up 00 or 

FF in unused space 

Select whether to simplify assembly 

Select whether to protect programming 

Input programming times 

Select generate file after 

assembly 

Select whether to reset 

program when stack full 

Select whether to need 

programming times 
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Generate Files    Choose generated file after assembly 

Stack Option  Choose whether to reset when stack overflow or stack full after OTP program operation. 

No Use Area Fill  Fill up 00 or FF in unused program space after assembly. 
Smart Compiler  Choose whether to simplify assembly. 
Enable Program Times  Choose whether to enable Download program times. 

Input Program Times  Input Download program times (Maximum: 2147483646. Minimum: 1). 

    After assembly finished, click “ICE Test” to test whether ICE operation voltage is normal as Figure 72 

(Connect Adapter 9V and connect USB Line to ICE. Make sure the ICE is connected, and then click “Option”).  

 

Figure 72 
  VPP voltage when programming: 5.6<VPP<6.6 

VDD voltage when programming: 2.7<VDD<3.6 
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4.2 Operation Procedures 

 
Figure 73 
Open  Open the programmed source code main file. 

Open Project  Open the saved project. 

Save Project  Save the finished project. 

Download file to Flash Memory  Download the finished Hex file after assembly to programmer or IDE Flash 

Memory. 

4.2.1 Open File and Assembly 

Open assembly main file 

Open project 

Save project 

Load Hex file into IDE 

Flash Memory 
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Display 
Assembly Main 

File Name
 

Figure 74 
Open source code main file and it will be displayed under assembly main file name. If the displayed name 

differs from main file, points the mouse to the specific file and presses mouse right key. Set this file as the 

assembly main file as shown in Figure 75. 
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Click right key 
of the mouse 
and select Set 

Main File

 
Figure 75 
Assembles Source Code and download the file to programmer or IDE Flash Memory, as Figure 76 illustrated.  

Assemble and 
download to IDE 
Flash Memory

 
Figure 76 

Display the program times that this program can 
be burned

Display successful Download to programmer or 
IDE Flash Memory

 
Figure 77 
When using USB interface, the program code will be loaded into programmer or Flash Memory of IDE after 

assembly main code finished for mass production programming. 

If there is enabled program times in the assembly option, information column will display the programming 

times as shown in Figure 77. 

After assembling completed, Hex filename and Checksum will be displayed underneath, as Figure 78 

illustrated. 
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Figure 78 
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4.2.2 Download HEX File 
This function is no longer support since HyconIDEDMM V3.0 vervison. 
If you would like to download Hex File, please conduct as the way of Compier Source 
Code . 

 
4.3 PC Online OTP Programming 

 

Figure 79 

 
Figure 80 
Blank Check, Programming, Verify and Read Commands can be implemented when the programmed file 

being successfully loaded into programmer or IDE Flash Memory. On the contrary, those commands will not 

be activated if the download failed. 

OTP Chip does not 
match with the 

selected IC

 
Figure 81 

OTP online

 
Figure 82 

 
Figure 83 
Make sure the selected programming IC part number is the same with the OTP part number in the topic 

window as Figure 70 described. When programmer executes Blank Check, Programming and Verify 
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commands, program will check whether the IC part number and OTP programming part number are identical. 

If the part number is different, the data will not be written into OTP and an error message will be displayed in 

information column as 81 described. 

If users intend to find out whether the part number is correct before programming, point the cursor to ”IC 

Connection Status Display” and click the mouse left key. If the selected IC is correct, a message will show up 

as Figure 82. If it is incorrected, the message will be displayed as Figure 83. If “Enable Program Times” has 

been marked up, the spare program times will be displayed in the message column as Figure 84 illustrated. 

 

 
Figure 84 

4.3.1 Blank Check 

Blank Check icon is . The internal code of Blank ICs that have yet not been programmed is 0xFFFF. The 
purpose of checking the IC is to make sure the OTP address content is 0xFFFF. Blank Check means whether 

the OTP addrss content is 0Xffff.If the IC selection is correct and the content is empty, a message will appear 

as Figure 86. 

 
Figure 85 
If the IC selection is incorrect or the content is not empty, a message will show up as Figure 86. 

 
Figure 86 

4.3.2 Program 

The icon of Program is . The purpose of programming is to write Compiler accomplished program into IC 

OTP. When programming is completed and the IC is assembled as finished goods, programmer can operate 

the program as user commanded. 

Program the downloaded or assembly finished Hex file (displayed at the bottom of the column) in the selected 

IC and verify the correctness of the programming content (please refer to Chapter 4.2.1 or 4.2.2 for 

programming procedures). 

If the selected IC is correct and programming succeeds, message will appear at the information column as 

Figure 87 illustrated. If “Enable Program Times” is ticked up, the enable program times will minus 1 and the 

program times left will be revealed in the message column. 
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Show Program Times
(If Program Times Function had been Enable)

 
Figure 87 
If the IC selection is incorrect and the programming fails, a message will show up as Figure 88. 

 

Figure 88 

4.3.3 Verify 

The icon of Verify is . The purpose to verify programming IC is to compare if the program written into IC 

OTP equals to the program downloaded to programmer. 

Verify programming IC content consistency with the downloaded or assembled Hex file (displayed at the 

bottom of the column). If the IC is protected by program, this verification is ineffective or the comparison failed. 

If IC selection and program verification is successful, a message will appear as Figure 89. 

 

Figure 89 
If IC selection is incorrect or the program verification miscarries, a message will pop up as Figure 90. 

 
Figure 90 

4.3.4 Read 

The icon of Read is . The purpose to read the IC is to verify the consistency of OTP Checksum and 

programmed Hex file. To read IC content, the procedures are illustrated as Figure 91. Its content will reveal 

at ”Display Code” window. 

If the IC is protected by program, this function is ineffective or the comparison failed. 
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Figure 91 
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4.3.5 AUTO 

The icon of Auto is . Auto integrates Blank Check, Program and Verify function. If user selects Auto, it will 

first check whether the IC is blank, then to program and verify. 

After the execution succeeded, a message will be displayed as Figure 92 displayed. If the option, ”Enable 

Program Times” is ticked up, the program permitted times will reduce 1 and the program times left will be 

shown in the message column. 

 

Figure 92 
If any function fails, the whole process will stop and display an error message in the message column. 
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4.4 PC Offline Programming 
4.4.1Programming Description 

As the development process evolves to engineering trial production, the programmer can be used alone. It is 

not necessary to connect programmer to PC. 

9V

Ground

ICESDO1 
2

3

4

5

6
VSS

ICESCK
ICECS

ICESDI
VDD

ICESDO

VSS

ICESCK

VDD   (3V)

ICESDI

VPP   (6V)

5

3

1 
2

4

6

ProgramBlank
Check

S1S2

D4

J4

U7

J1

J5

HY-IDE 
USB Control Board

 
Figure 93 
J4 : Adapter 9V input 

 supply programming power source, connected when programming OTP  
U7 : USB connector to PC 

Downloading program for emulation and debug 

Downloading programming code for HY12P series 

J5 : HY12P series programming control port 

PIN 1  VP P (6V) connects to VPP of the IC 

PIN 2  ICECK     connects to PSCK of the IC 

PIN 3  ICESDI connects to PSDI of the IC 

PIN 4  ICES DO    connects to PSDO of the IC 

PIN 5  VDD(3V) connects to VDD of the IC 

PIN 6  VS S  connects to VSS of the IC 

S1 : IC programming button 

S2 : Blank Check key 

D4 : Two-color LED； 

Red LED: OTP programming, Blank Check…failure signal. 

Green LED: OTP programming, Blank Check…success signal. 

Green LED: USB/Adapter power-on signal. 
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Figure 94 shows the connection way of connecting programming IC to control board programming pin when 

PC online. 

 

 

 

 

 

 

 

 

 

 

 
 
 

Figure 94 
Figure 95 shows the connection way of connecting offline programming IC to control board programming pin 

after program finish download when PC offline.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 95 
To implement offline operation, Hex file must be firstly downloaded to programmer Flash Memory. The 

procedure can refer to chapter 4.2.1 or chapter 4.2.2. 

To implement offline operation, press S2 button to check if the IC is blank and the D4 Green LED should be 

lighted up. 

S1 Button is programming button. Its procedures are: Blank Check  Program  Verify. If ”Program 

Protection” of “Assemble Option” is ticked before downloading data to Flash Memory, program protection will 
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be executed after Verify completed. If ”Program Protection” is not picked up, it will stop after Verify 

accomplished and D4 Green LED will be lighted up.  

When Programming finished, please press S2 to check if the IC is blank. At this moment, the D4 Red LED 

should be lighted up, which means the programming is successful (data has been programmed into IC, so 

Blank Check failed). 

If any failure or error happened during execution procedures, D4 Red LED will be lightened up. On the 

contrary, D4 Green LED will be lighted up if success. 
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4.4.2 Program Times Restriction 
The menu of ”Assemble Option” in interface setup has an option of ”Enable Program Times” as described 

Figure 71. This option restricts the permitted program times of download program. 

This is a safety mechanism that restrains the permitted program times, preventing it from over-programming 

on the production line. 

After ticking up ”Enable Program Times”, key in the program times in the column below ”Input Program Times” 

(maximum is 99999999, minimum is 1). This argument will be written into EEPROM of the programmer after 

the compiler programmed file is downloaded to Flash Memory. Afterwards, the enabled program times will 

reduce 1 each time when programming completed. If the value reduced to 0, the programming action may not 

be executed. At this time, an error signal (Red LED) will be lighted up but Blank Check still operates normally. 

5. Troubleshooting 

5.1HYCON-IDE Execution Problem 

 

The problem might be happened under Microsoft Vista or Windows 7 system environment. To avoid the 

problem, the limit of authority for HYCON-IDE execution has to be set as system administrator to execute 

HYCON-IDE by administrator status. 

 
 

 
 
6. Revision History 

Major differences are stated thereinafter: 
 

Version Page Revision Summary 

V01 ALL First Edition 

V02 CH4.2.2 Remove ”Download Hex File” function description 

   

   

 

.

http://www.hycontek.com/

	1. HYCON-IDE Overview
	1.1 Introduction
	1.2 HYCON-IDE Installation and System Requirement
	1.3 Install and Remove
	1.3.1 Install

	1.4 Registration
	1.5 Demo Code Description

	2. HYCON-IDE Interface Description
	2.1 HYCON-IDE Edit Interface
	2.1.2 File
	2.1.3 Edit


	3. HYCON-IDE Debug Interface
	3.1 Fast Execution
	3.2 RAM Window
	3.3 Register Window
	3.4 Watch Window
	3.5 Stack Window
	3.6 ADC Window
	3.7 Power Window
	3.8 MPN Window
	3.9 Register Record
	3.10 Hint Function of Source Code Window

	4. Programming Windows
	4.1 Interface Setup

	5. Troubleshooting
	5.1HYCON-IDE Execution Problem

	6. Revision History

